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1. Introduction 
RangeNav™ is a transportable acoustic tracking range.  It is designed to track pinger equipped targets for applications 
including underwater vehicle performance evaluations and monitoring of underwater assets in naval exercises.  
Characteristics include: 
 

• A compact, transportable design suitable for quick deployment and recovery at any desired test site. 

• Specifically optimized for littoral waters, and capable of operating at depth ranges from 1m to 300m. 

• Designed for coverage up to 20 nautical miles x 20 nautical miles. 

• Automated acoustic self-survey determines relative station locations within minutes. 

• Simultaneous tracking of up to eight targets in three dimensions with horizontal accuracy of approx. 1 meter and 
vertical accuracy of approx.  0.3 meters.   Position quality indicator provides estimated accuracy of each fix. 

• Standard position update rate of once per second for all targets. 

• Compatible with Desert Star depth-encoded pingers and US Navy standard DPSK pingers. 

• Broadband, DSP based design operating from 2 kHz to 80 kHz.  

• Simple surface equipment consisting of a junction/power box and a MS Windows notebook computer or desktop. 

• Client-server architecture supports tracking data viewing in remote locations via the Internet or LAN. 

• Uncomplicated and rugged hardware that enables use of locally available labor and vessels of opportunity. 

• A relatively low-cost design permits use in ‘risky’ locations where equipment loss is a possibility. 
 

 
 
 

RangeNav™ Systems consist of a number of interconnected listening stations  
linked to a surface junction/power box and PC. 

 
RangeNav™ systems are configured from the principal components listed in this chapter.  In general, the information in 
this operator’s manual is sufficient for most tasks.  Additional detailed information about the components is available in 
these RangeNav™ Manuals: 
 
 

RangeNav™ Technical and Software Reference Manuals 
1. The DiveBase RangeNav™ Software Reference Manual describes the surface station software.  
2. The TLP-100-101-102 Technical Reference Manual describes the standard pingers. 
3. The TLP-103 Technical Reference Manual describes a micro pinger for small targets. 
4. The RBS-100-101 Technical Reference Manual describes the listening stations. 
5. The STM-100 Technical Reference Manual describes the surface station junction box. 
6. The RPD275-550-1100 Technical Reference Manual describes the array data and power cable. 
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RBS-100 Listening Stations 
 

At the core of a RangeNav™ system 
are a set of model RBS-100 
broadband listening stations.  The 
stations are linked in a daisy-chain 
fashion, with up to 100 stations per 
chain and a maximum supported 
chain length of 20 nautical miles if 
stations are spaced in 1km intervals.  
An anticipated expansion will allow the 
use of multiple chains, so that a 
coverage of up to 20nm x 20nm can 
be achieved. 
 
These ‘intelligent’ listening stations 
receive acoustic signals from the 
pingers through a broadband 
hydrophone and transmit transducer 
assembly that is attached to the 
station via a short (1.5m) cable.  
Signals are processed in the station 
using filter and telemetry decoding 
parameters provided per remote 
command by the surface station.  In-
station acoustic signal processing 

greatly reduces the data volume to a brief ping descriptor, which is transmitted via a RS-485 copper-based data link to the 
surface. 
 
In addition to their broadband acoustic receive capability, the listening stations are also equipped with an acoustic 
transmitter and transducer, operating at 16kHz – 24kHz.  The acoustic transmit capability is used primarily for array self-
survey,  providing a speedy and very accurate means to determine station locations relative to each other.   
 
In order to determine precise depth of their location, each station is equipped with a 0.1% of full scale accuracy pressure 
sensor.  The pressure sensor rating is 500 PSIA, supporting the station’s 300m depth rating.  Each station reports its 
depth to the survey as a part of the array self-survey process. 
 
The listening station are powered by 50/60Hz AC power from the surface junction box, and can be configured to operate 
at either 880 VAC or 440 VAC nominal.  The higher voltage supports maximum chain length, but the lower voltage is a 
safer solution for applications or in areas where human interaction with the system is common.  Each station relays both 
power and conditions and relays data down (and up) the chain. 
 
In addition to its main DSP processor, the listening stations include a micro-controller which is exercising supervisory 
function.  These include a data and power bypass that is activated if the DSP chip is not responsive.  The mechanism 
allows the remainder of a chain to keep operating even if the DSP circuitry in one station is defective. 
 
 
 
RBS-101 Recording Stations 
The model RBS-101 recording station are identical to the RBS-100 listening stations, except that a CF FLASH memory 
card is integrated and raw acoustic data recording firmware is provided.  Due to its copper/RS-485 data interface, 
umbilical communication bandwidth is limited and not suitable for continuous raw acoustic data transmission by all 
stations in a chain.  (Doing so is not normally necessary, because each station processes the acoustic data and needs to 
send only short ping descriptor packages). 
 
Yet, the RBS-101 station helps when there is a need to obtain occasional samples of raw acoustic data, such as to 
evaluate background noise or measure the noise signature of a target.  The surface station can instruct any listening 
station to record the raw data.  The data is stored in the FLASH memory, and can be retrieved by the surface station on a 
bandwidth available basis.   FLASH card capacity is 1 GB standard 8 GB optional.  The 1 GB standard capacity is 
sufficient for approx. 30 minutes of raw data recording at the standard sample rate of 250 kHz. 
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 Data and Power Cable 
The RBS-100 listening station and RBS-101 recording stations are 
linked to each other and the surface junction box through the data 
and power cable.  Cable sections of 250m, 500m and 1000m are 
available.  Each section is terminated with wet-mateable (diver 
serviceable) underwater connectors and a ‘chinese finger’ strain relief 
system.   
 
The cables include a cut and abrasion resistant clear polyurethane 
jacket that supports inspection, a Kevlar braid strength member and 
water swelling tape to slow cable flooding in case of a cut.  The 
maximum working load is 500lb and the breaking strength is 1500lb.  
The cable is negative buoyant.   
 
A 250m spool weighs approx. 85lb.  The six-conductor cable includes 
an AC power pair, plus two twisted data pairs supporting two RS-485 
data channels. 
 
 
 
 
 
 
 
 
 
 
 
 

 
STM-100 Junction and Power Box 
Each chain is terminated at the surface to a model STM-100 
junction and power box.   The principal functions of the STM-100 
are power generation and handling and data relay between the 
underwater array and the surface station PC. 
 
The STM-100 connects to 50/60Hz AC power and is factory 
configured for either 110VAC or 220VAC operation.  It converts the 
power to either 440VAC or 880VAC before feeding it into the array. 
 
A power monitoring operates in conjunction with reports from the 
listening stations, and provides continuous reports about the 
voltage at each station and the current flowing through each 
conductor of the power pair.  The power monitoring helps 
determine the max. available chain length (before voltage gets too 
low), and detect any faults such as leakage currents, defective 
station electronics or short circuits.  For safety purposes, the STM-
100 also cuts power to the array if either a sudden current spike or 
a ground fault (current mismatch) is detected. 
 
The STM-100 also includes an input for a GPS time signal.  In 
conjunction with a similar input available on the depth coded 
pingers, the time signal allows direct pinger-to-listening station 
distance measurements (as opposed to the normal distance 
differences obtained with unsynchronized pingers).  This mode is 
sometimes used to improve the array GPS surveys accuracy and 
reliability. It yields station coordinates for each listening station 
individually, and completely independent of the other listening 
stations.   
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Surface Station PC and Software 
The surface station PC connects to the STM-100 junction box via a RS-485 
converter that plugs into a USB port on the PC.  The converter and cable are 
supplied as standard accessories.  A powerful Windows XP notebook PC is 
sufficient to service a maximum length chain, because the computing intensive 
raw acoustic data processing has already been performed by each listening 
station. 
 
The PC runs the RangeNav™ software, which computes and displays target 
tracks, resolves array self and GPS surveys and monitors the array health 
status. 
 
Due to the small size and minimal power demands of the surface station, it is 
quite practical to operate a RangeNav™ system from a trailer or control van 
using line power or a generator. 
 
 
TLP-100, TLP-101, TLP-102 and TLP-103 Depth Encoded Pingers 
The RangeNav™ system is designed to track pinger equipped targets.  These 
may be standard U.S. Navy DPSK pingers, or Desert Star’s depth encoded 
pingers.  Four pinger types are currently available: 
 

1. The TLP-100 low-frequency pinger operates at 8-16 kHz with a transmit 
power of 192 dB.  It includes a precision 500 PSIA depth sensor, with an 
accuracy of 0.5 PSI.  The TLP-100 yields the greatest range and 
therefore supports maximum station spacing. It is also the largest 
design. The TLP-100 is intended primarily for tracking submarines and 
large UUV. 

 
2. The TLP-101 is similar to the TLP-100, except that the frequency range 

is 16-24 kHz.  This mid-frequency pinger is suitable for smaller vehicles 
as well as divers. 

 
3. The TLP-102 high-frequency pinger operates at 34kHz-42kHz, and is 

otherwise identical to the TLP-101 including a housing of the same 
size.  The higher frequency produces somewhat less range and thus 
requires denser station spacing, probably not to exceed 500m.  In 
multi-target tracking, using this pinger along with models for the two 
other frequency bands provides better ping frequency separation for 
more robust tracking. 

 
4. The TLP-103 micro-pinger also operates at 34kHz-42kHz, but comes 

in a much smaller package.  It is suitable for micro UUV, divers and 
other small targets.  Transmit power is limited to 177 dB, and as such 
listening station spacing should not exceed 250m.  Its 500 PSIA 
depth sensor has an accuracy of 5 PSI. 

 
    
 
 

TLP-100 

TLP-101 

TLP-102 

TLP-103 
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Figure 2: 

Firmware Update 

2. RangeNav™ Software, Firmware and Driver Installations 
 
SEALEVEL P/N 2104 RS485-USB Converter 

1. This converter is used for communication between the surface station PC and the STM-100 junction box.  Prior to 
first use, open the black housing of the converter using a small flat-head screwdriver for gently prying.  Set 
switches 1-7 to the ON position and switch 8 to the OFF position.  This setting configures the converter for two-
wire RS-485 operation. 

 
2. Now connect the converter to a USB port of the surface station PC.  The PC will detect the new device and start 

the hardware installation wizard.  Insert the SEALEVEL CD ROM and follow the instructions of the wizard. 
 
  
RangeNav™ Surface Station Software Installation 

1. Insert the RangeNav™ CD ROM 
2. The CD should auto-launch.  Follow the wizard instructions.  If the CD does not auto launch, then use Windows 

Explorer to click on the Setup icon. 
3. Start the RangeNav™ software. 
4. Configure the software for communication with the STM-100 junction box by selecting the COM port that the 

SEALEVEL converter has been assigned to.  Do this by selecting Setup->Data Connections from the main 
menu.   The figure below shows proper configuration through a SEALEVEL device on COM4.  The standard baud 
rate is 115200 baud. 

 

 
 

Figure 1: Configuring the connection between the PC and the STM-100 Junction Box 
 

 
Updating the RangeNav™ Array Firmware 

The firmware on the RBS-100 listening stations, RBS-101 recording 
stations and STM-100 junction box is updated on occasion.  New firmware 
can be downloaded to the entire array while deployed, or it can be 
downloaded to individual stations or a set of stations at the maintenance 
depot.  Downloading new firmware to a deployed array is an acceptable 
practice to test newly developed capabilities.  However, you should always 
have a production approved version of the firmware at hand, to revert to in 
case a bug should become apparent.  
 
To update firmware, connect the array as you would for operation (PC to 
STM-100 to a number of RBS-100 or RBS-101 stations).  Then, power up 
the array.  (If you use automatic power-up, make sure the Start 
Application on Power Up check box is not selected).  Next, select Setup-
>Update Array Firmware.  Click the Update Firmware button and select 
the new firmware file in the browser.  The firmware has a .VC extension.  
The window will show progress information.  Once download is completed, 

click the Run Application button to launch the updated firmware. 
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Figure 3: Array Power Window, Automatic Tab 

3.  Systems Wiring and the Array Power Up / Down Procedure 
 
System Wiring 
Wire a RangeNav™ system for operation as follows: 
 

1. Link the surface station PC to the STM-100.  A USB port on the PC connects to the PC port of the STM-100 using 
the supplied SEALEVEL RS-485 converter and STM-100 data cable. 

2. Connect the STM-100 to 50/60 Hz AC power (110VAC or 220VAC only as indicated on the STM-100 panel) using 
the supplied marine power cord. 

3. Connect a hydrophone / transmit transducer assembly to each RS-100 listening or RBS-101 recording station.  
The transducer assembly connects via a 1.5m 4-conductor cable. 

4. Use an umbilical cable section (275m, 550m or 1100m spool depending on desired listening station spacing) to 
link the STM-100 junction box to the first RBS-100 listening station or RBS-101 recording station.  The cable 
section links the ARRAY connector of the STM-100 to the ‘upstream’ connector of the listening/recording station.  
(The connector polarity arrangement assures correct connection).   

5. Connect the ‘downstream’ umbilical connector of the first listening station to the ‘upstream’ connector of the 
second listening station using another umbilical cable section.  Continue in this fashion to the end of the chain. 

6. Terminate the downstream connector of the last listening station or cable section with a dummy plug to prevent a 
water short circuit of live wires. 

7. Optionally, connect the one-second time signal output (TTL signal) of a GPS receiver to the GPS input on the 
STM-100.  The GPS time signal can be used to synchronize the listening station array to GPS triggered pingers 
for improved absolute (earth coordinate) array surveys. 

 
 
System Power-Up Procedure 
The RangeNav™ system uses power relaying.  440VAC or 880VAC power is injected by the STM-100 junction box into 
the ‘upstream’ end of the array.  The power reaches the first listening station, which relays the power on command to the 
second listening station and so on until the entire array is energized.  Power relaying allows operation of an only partially 
energized array, such as to operate an array upstream of a cable cut (short circuit avoidance), to allow service at a point 
of failure, or when only a partial array is needed for a tracking task.   
 
The RangeNav™ system also monitors the current flowing through each of the two power conductors, and the voltage 
seen across the conductors in real-time.  The electrical current data is useful as an early warning sign of impeding failure 
such as due to a bad connector, cable cut or deteriorating transformer.  It is also used by the RangeNav™ safety system 
to automatically cut power if a ground fault (current imbalance) or a current spike has been detected.  The safety system 
minimizes the risk of both electrocution and equipment damage.   
 
The power up sequence for the array can be executed automatically, or listening stations can be powered up or down 
individually using the manual power procedure. 

 
Automatic Power-Up 
Use this procedure to execute a standard power-up of 
the entire array. 

1. Select Array->Power 
2. Select the Automatic tab. 
3. Leave the Start application on power up tab 

checked if you wish to initiate tracking 
immediately following the power-up.  Un-check 
the box if you are powering up the array in 
order to update firmware or perform other 
maintenance functions. 

4. Hit the Start Power Up button.   
Automatic power-up now starts, one station at a time.  
As each station is powered up and communicates, its 
serial number appears and a bra indicates the AC 
voltage seen by that station.  You will also see the AC 
current rise with each energized station.  Familiarize 
yourself with the typical ‘look’ of the voltage curve and 
the incremental current increase.  This will help you 
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spot problems down the road. Each station power-up and initialization typically takes 10-20 seconds.  If the surface 
station does not see communication from another listening station within 30 seconds of energizing the next cable 
section, it assumes the entire array is powered up.  The array power-up completion pop-up window then appears.  
You are now ready for tracking operations. 
  
 

Manual Power-Up 
Use this procedure to manually power-up (or down) one station at a time.  Manual power-up provides more operator 
control and is available for various diagnostic and maintenance purposes. 
 

1. Select Array->Power 
2. Select the Manual tab 
3. To power up the next station, hit the Power-Up 

button. 
4. To send a power up or down command to a 

specific station (i.e. power up/down the next 
station downstream from that station), select its 
serial number in the list and hit the Power Up or 
the Power Down button. 

5. To verify umbilical communication with all stations 
and re-establish their serial numbers, hit the 
Enummerate button.  This is useful to determine if 
a station’s main processor may have failed and 
has been bypassed by the station’s supervisory 
processor.  In that case, its serial number will no 
longer appear but stations further downstream 
may still be available. 

6. To start or stop power monitoring, hit the Start 
Power Monitor / Stop Power Monitor button.  In 

general, it is recommend to keep power monitoring active at all times.  An exception might be to conserve 
umbilical communication bandwidth for tracking functions in a large array. 

7. To start the tracking application following manual power-up, click the Start Application button.  Once started, you 
cannot exit an application.  Instead, it will be necessary to power-down and the power-up the array if you wish to 
perform functions such as firmware update. 

8. Click the Log data check-mark if you wish to record all power data.  Use this capability to create a power log for 
diagnostic or Desert Star technical support purposes. 

 
Array Power-Off 
To quickly power-down the entire array, flip the STM-100 power switch to the OFF position.  You can also go to the 
manual power screen, select the first station (this is actually the STM-100) and send it a Power Down command.  Use a 
similar procedure if you wish to power-down a portion of the array. 
 
Detecting and Dealing with Power Faults and Array Size Limitations 
RangeNav™ operators should make it a habit to monitor the power characteristics of the array.  This will allow you to 
notice early warning signs of faults such as leakage currents due to a bad cable or connector, or a bad listening station 
before such a problem causes an automatic array shut-down.  Further, the ‘voltage curve’ formed by the sequence of 
listening stations indicates when you are approaching the maximum available length of the array due to excessive voltage 
loss.  The following list provides some advice on these matters.   
 

• The low-voltage limit for arrays configured for 440VAC operation is 240VAC.  Array voltage will drop in each cable 
section due to cable losses.  When the last station sees 240VAC, you have reached the limits of operation and 
the array cannot be extended any further.  The low-voltage limit for arrays configured for 880VAC operation is 
480VAC. 

• Each additional listening station will increase current in the array by about 15mA – 30mA.  If you see an 
incremental current above 30mA, the downstream end listening station may be defective.  If the incremental 
current is below 15mA, then the station is probably not seeing power such as because you are at the end of the 
array (no further stations) or because there is a broken power conductor. 

• A cable by itself without a further station will in fact consume power.  That is due to the capacitive and inductive 
characteristics of the cable in conjunction with its ohmic resistance.  If you daisy-chain two or more cables without 
a station, you will see a higher incremental current for that extended cable section. 
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Figure 5:  Defining Operating Channels 

• The incremental current curve may not be completely even, because energy is stored in the cable system’s 
capacitive and inductive characteristics and some currents may circulate locally. 

• There are signs that a given listening station may in fact see a slightly higher voltage than its upstream neighbor.  
This may be due to localized energy storage in the cable. 

 

4.  Defining The Array Operating Frequencies and Signal Monitoring 
 
RangeNav™ is a programmable broadband system, with frequency coverage from 600Hz to 80 kHz. Prior to operation, 
you must define the operating frequency channels, both for the array and the pingers.  The single-target version of 
RangeNav uses three channels: 
 

• Channel 1 is the self-survey frequency.  This should always be 16 kHz. 

• Channel 2 is the synchronization frequency of the depth coded pinger.  It is pinger model specific. 

• Channel 3 is the depth telemetry ping of the depth coded pinger.  The frequency is pinger model specific. 
 
Operating frequencies and filter characteristics are defined by FIR filter files, which have a .fir extension.  Table 1 lists 
currently available filter files.  
 
Filter Name Center Frequency Bandwidth (@ -3dB) # of coefficients Use for 

16000Hz.fir 16 kHz 800Hz 398 Ch. 1 self survey 

8492Hz.fir 8.4925 kHz 800Hz 398 Ch. 2 for TLP-100 

10498Hz.fir 10.498 kHz 800Hz 398 Ch. 3 for TLP-100 

16528Hz.fir 16.5289 kHz 800Hz 398 Ch. 2 for TLP-101 

18518Hz.fir 18.5185 kHz 800Hz 398 Ch. 3 for TLP-101 

34482Hz.fir 34.4828 kHz 800Hz 398 Ch. 2 for TLP-102/103 

36363Hz.fir 36.3636 kHz 800Hz 398 Ch. 3 for TLP-102/103 

Notes: 
1. The filter bandwidth defines the frequency range passed by the filter.  A larger bandwidth accepts a higher 

maximum target speed (allowance for Doppler effect) and yields better ping time detection accuracy.  It also 
passes more noise and therefore reduces the maximum detection range. 

2. In order to achieve desired filter characteristics, a certain number of filter coefficients is needed.  In general, 
sharper filters (less bandwidth and/or better stopband rejection) also require more coefficients.  However, a filter 
with more coefficients will increase the time-uncertainty of ping detection, resulting in reduced tracking accuracy.  
The processing power requirement also relates to the number of coefficients. 

 
Table 1:  FIR Filter Files 

 
Programming the Channel Frequencies of the Array 

1. Select Array->Channel Editor 
2. To add a new channel (you must have three channels 

defined for single-target tracking), hit the Add button 
3. Select the .fir filter file for the first/next channel in the 

browser, using table 1 for guidance.  The next free channel 
number will be automatically assigned. 

4. To change a channel definition, select the channel in the 
list and hit the Edit button. 

5. To delete a channel, select the channel in the list and hit 
the Delete button.  The remaining channel numbers will be 
re-assigned. 

6. Once your channel definition list is complete, hit the 
Download Channels to Array button to download all 
channels to all energized listening stations. 

 
 
Programming the Channel Frequencies of the Pinger 

1. Connect the pinger to the COM port of the MCU-5 charging/configuration station. 
2. Connect the USB port of the MCU-5 station to a USB port of your PC using a standard USB master/slave cable. 
3. Start the HyperTerm utility on the PC, select the assigned COM port and select 4800 baud 
4. Follow the prompts or pick up the technical reference manual to see how to configure the pinger. 
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5.  Deploying and Recovering the RangeNav™ System 
 
All RangeNav deployment techniques require assembling the chain of cable sections and listening stations.  Depending 
on the deployment technique, this may be done prior to boat departure or while the deployment is in progress.  The 
assembly process is as follows: 
 

1. Connect each listening station to its stainless steel strong-back and lead weights, making sure it is well centered.  
Use two stainless-steel hose clamps to secure the station.  Loop the hose clamp around the station and strong 
back, and through the two slots of the 5 lb lead weight.  Place a 1/8” thick neoprene rubber pad between the 
station and the strong back at each hose clamp.  Important:  The rubber pad is needed both to avoid long-
term bending of the Delrin station housing and as part of the shock absorption system.  Do not omit it.   
Tighten the hose clamps only moderately (approx. 12 inch-pound).  The station should be snug, but still be able to 
slip somewhat if dropped on deck onto the end of the strong back. This is part of the shock absorption system. 

2. Connect the hydrophone/transducer assembly to each station using the supplied cable.  Make sure to secure the 
locking sleeve on both ends of the cable all the way to assure a positive connection.  IMPORTANT: Secure the 
cable ends to the strong back using cable ties.  This is necessary to prevent repeated flexing at the 
connector, which has been shown to cause long-term failure of the data conductors due to stress. 

3. Connect the supplied or an alternate flotation device to the transducer assembly.  The supplied float is 6” 
diameter, provides about 3.8 lb of flotation  and has a maximum working depth of 400m.  Use larger floats if there 
are substantial water currents in the area.   Keep in mind that more weight may be needed as well. 

 
 
 

  
 

Figure 6A: Rigging the Listening Stations for Deployment 

 

Hydrophone & transmit 
transducer assembly 

Listening Station 

RPD 
Cable Spool 

Connect 6” trawl float to 
cage.  Use 6”-12” 
linkage line between 
hydrophone and float. 

Use two 5 lb standard 
diver lead weights 

Strong-Back 

Use shackle to link 
strong back to cable 
strain relief system 

Tighten hose clamp until 
snug.  Do NOT over 
tighten.  Station must be 
free to move slightly 
when dropped on end – 
shock absorption 
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Figure 6B: Listening Station Rigged with Strong-Back & Weights 
 
The RangeNav™ array consists principally of listening stations interconnected by cable sections.  There are several 
deployment techniques, each with its own set of advantages and disadvantages.  Recovery is generally the reverse of the 
deployment process. 
 
Array assembly while deploying 
Cable sections and listening stations may be stored unassembled on deck and/or in the hold.  Each cable section is on a 
spool.  For deployment, a cable section is mounted on an un-powered rack and cable is spooled out over the stern of the 
boat.  As a spool is almost paid out, the boat slows and stops.  The crew connects the next listening station and mounts 
the next spool.  The process continues to the end of the array.  To aid recovery, the empty spools are mounted on a 
winch.   
 
This method requires least cable handling equipment and can therefore be done from very small boats.  It has excellent 
electrical safety, because the crew is not handling energized cables.  However, the approach is very labor intensive and it 
may be difficult to keep the boat steady at the ends of sections as listening stations must be connected and spools 
swapped out.  There is also no array monitoring during deployment, and thus faults will not be uncovered until deployment 
is complete. 
 
Deploying multiple pre-assembled sections from a figure-8 rack 
 A number of cable sections and listening stations are interconnected on shore and the cable is figure-8 mounted across 
two posts.  The upstream end of the array is connected to the STM-100 and the entire array is energized and tested prior 
to deployment.  During deployment, the array remains energized for continuous monitoring.  The cable is deployed over 
the stern of the boat, and listening stations are lowered into the water as the end of each section is reached.  If the rack 
cannot hold all sections, then the downstream end of the last cable section is terminated with a dummy plug, equipped 
with a flotation device and left floating in the water.  A new set of sections is assembled, loaded and tested. It is connected 
to the array, and the process continues.   
 
This technique supports array testing prior to deployment and monitoring during deployment.  Problems are therefore 
quickly noted and corrected.  Cable handling equipment requirements are minimal, and support use of a small boat.  
There is no need for the boat to stop at the end of each cable section, allowing for a more precise deployment.  However, 
the figure- process is labor intensive and care must be exercised because the crew is handling energized equipment. 
 
Mounting multiple sections on a large, powered winch 
A number of cable sections and listening stations are pre-assembled and mounted on a large winch.  The winch is 
equipped with holders for the listening stations.  The winch is also equipped with a slip ring, so that the array can be 
energized and monitored. The cable and listening stations are deployed over the stern of the boat, and the winch power is 
used during recovery. 
 
This process requires least labor during deployment and recovery.  It supports array testing prior to deployment, and 
monitoring during recovery.  However, it also requires a large winch and a larger boat to handle the equipment.  Care 
must be exercised because the crew is handling energized equipment. 
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6. Conducting an Array Self-Survey 
 
The acoustic self-survey measures the distance of the listening stations relative to each other. This information in turn is 
used to compute the coordinates of the stations, expressed as meters ‘north’ (northing) and meters ‘east’ (easting) of a 
point of origin.  You will need to pick three ‘anchor stations’ as a starting point for the system’s listening station position 
computations. You do not need to know the exact location of those three stations, but they should be located in a triangle 
configuration as opposed to a line and must be within range of each other. This will give the best results.   
 
Anchor station #1 will become the origin of the coordinate system (N=0;E=0).  The line between anchor station #1 nad 
anchor station #2 forms the easting axis, and therefore the location of anchor station #2 will always be a Northing of zero 
and an Easting equivalent to that station’s distance from anchor station #1.   
 
Follow this procedure (see screen dump below): 

1. Select the Acquire Data tab in the array survey window. 
2. Enter a reasonable Cycle Count such as 5 or 10 tries.  A greater number of cycles (distance measurement 

attempts per station pair) results in better data quality due to averaging, but also takes more time:  one second 
per cycle per station. 

3. Enter a sonar Transducer Depth Offset.  RangeNav measures all depths relative to a vacuum reference ( 0 
PSIA).  This allow the system to compensate for changing atmospheric pressures be it due to weather systems or 
because you are operating in a high altitude lake. The depth offset also allows you to compensate for the length 
of the listening station sonar transducer cable (normally 1.2m) In order to obtain the correct depth of the sonar 
transducer, enter the atmospheric pressure expressed in meters of sea water PLUS the length of the sonar 
transducer cable.  For oceanic work not during a hurricane or extreme low pressure system, the atmospheric 
pressure will be around 10m, resulting in a entry of about 11.2m (10m + 1.2m).   

4. Click the Depth Survey button to obtain the listening station depth from their sensors.   
5. Clicking the button Entire Array starts the acoustic self survey.  Survey progress, including the current cycle 

count is reported in the white status window in the lower right.  The range numbers in the matrix fill in as each 
range is obtained, and the Valid entry for a station turns green once sufficient survey data for that station is 
available.  You can stop the survey at any time by button press, or select a station row and then press Single 
Station if you wish to obtain self survey data for that specific station.  

6. When the acoustic self survey is complete (and all or most station’s Valid field has turned green), proceed to the 
Calculate Positions tab.  Select three anchor stations (see explanation in the introduction above), and then click 
Calculate Positions.  The software will now compute the relative position of all the stations, and display them as 
Northing and Easting coordinates.  The residual error for the overall survey is displayed in the status window, and 
the error for the position of each station in the Survey Data display row of that station.  The residual error is 
roughly equivalent to the position uncertainty of a station (or the average for all stations).  A smaller number 
means a better result.  You can change the anchor station selection and click Calculate Positions again to see if 
a better / more certain result might be obtained.   
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The below table explains how to explain the screen shot. 
  
 

 
 

Figure 7: Array Self-Survey Screen 

 
Survey Display Data Field Interpretation 

Station # (example Station 10) The number of stations in the array is displayed in the upper left corner 

Depth The depth of the station, as measured by its pressure sensor 

N The Northing location of the station 

E The Easting location of the station  

Valid Yes/No— Sufficient survey data to calculate the station position is available 
1

st
 Number—Number of other listening stations that heard the ping from this stn 

2
nd

 Number—Residual position error (position uncertainty) for that station 

Explanation of Colored Areas Red Question Mark—Means no data 
Yellow Block— Data available, but considered unreliable and not used 
Green Block—A valid position for this station is available 
Red Block—Sufficient data for a position computation is not available 

Calculate Positions tab Use to calculate station positions following a acoustic self survey 

Acquire Data tab Depth Survey—Press to obtain the depth of all listening stations 
Single Station—Acoustic self survey for that station only 
Entire Array—Acoustic self survey for the entire array 
Transducer Depth Offset—Compensation for atmospheric pressure and sonar 
transducer cable length 
Cycle count—Desired number of range survey cycles 

 
Figure 8:  Self Survey Screen Data & Controls 
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7. Tracking Operations 
 

 
 

Figure 9:  Tracking Display 
   
 

Tracking Display Information & Control Summary 
 

1. The Current Target Position is a small rectangle with the target ID code.  The single-target version of 
RangeNav uses the ID code M1 (mobile station #1). 

2. The Position Trace provides a history of target positions.  Each position fix is one small cross.  Many 
individual fixes in random locations, such as on the map above, indicate that the position filter settings are not 
stringent enough and should be changed by selecting Mobile -> Position Estimation Filter -> Settings.  If 
the screen gets to cluttered, select Mobile -> Clear Track. 

3. The Variable Grid Scale should be set to provide convenient scaling, such as for example 10m or 100m per 
grid line.  Select View -> Settings.  The view menu is also used to select the tracking display Pan, Zoom and 
Rotate functions.  Select one of these functions, point the cursor at the screen, left click and drag. If in Zoom 
mode, use left click to zoom in and the ‘–‘ key to zoom out. There is also a convenient Measure function.  
Select it, point, left click and drag to obtain distance and direction between two points. 

4. The Target Depth Display uses a slider to display the report of a depth encoded pinger.    
5. Numerical Target Information is available in the green display in the lower right corner.  Here you find the 

target information expressed as Northing and Easting, the Depth, and the time since last position fix in 
minutes and seconds (A).  The Error value in the lower right relates to the estimated accuracy of a fix, with a 
larger number corresponding to a greater error.  This number currently is in arbitrary units, but our goal is to 
provide an error estimation in meters in the future. 

6. The Listening Station Locations are small squares with the listening station serial number.  Color indicates 
the status of that station.  Red means the station has not reported a signal from the pinger, and green means 
that this station is seeing and reporting the pinger signal. As a pinger moves through the array, you can 
expect to see it surrounded by a ‘cloud’ of green stations that track its progress.  A station symbol may also 

Position Trace 

Target Depth Display 

Current Target 
Position 

Numerical Target 
Information 

Listening station 
location & status 

Listening 
station ‘status 
lights’ 

Variable scale grid 
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be blue. That means the station is powered up, but is still sitting in the boot loader and is NOT yet running the 
application.  You will see this when doing a power-up sequence without commanding the stations to run the 
application (for example in preparation for a firmware update). 

7. The Listening Station Status Lights provide the status of all listening stations at a glance.  The lights are 
not labeled, but the sequence corresponds to the physical listening station chain.  If there are too many 
stations for one line of lights, then the software displays multiple lines.  Read row by row from upper left to 
lower right.  The color encoded status information is the same as for the listening station location displays. 
The listening station lights use the same colors as the listening station location symbols (see above).  Blue 
means the station is in the boot loader (powered up, but not running the boot loader), red means the station is 
not seeing a pinger signal, and green means the station is seeing and reporting pinger signal information.  In 
addition, the status lights use shades of red and green.  A bright red or green will appear each time a report 
from that listening station has been received.  The color will then darken over a number of seconds until it is 
black.  A healthy station will report once per second, on so its color will stay bright with slight pulsing 
noticeable.  If properly synchronized to each other, all stations will also report at approximately the same time.  
So, a well working system will display a consistent and synchronous ‘heart beat’ of all stations, with each 
station either being red or green depending on if it is in the transmission range of the pinger. 

 
RangeNav has two principal modes.   Replay mode is available to review tracking data and is discussed in the next 
chapter. Real-Time mode is used for tracking and array survey alike.  Real-time mode is active whenever Replay mode is 
NOT selected, i.e. it is the default mode.  When in replay mode, you can switch to real-time mode by selecting  
File->Switch to Realtime Mode.  Assuming you have already powered up the listening stations, conducted an array 
survey and defined the channels used for ping pinger detection, you will be ready for tracking.  The display will now be 
similar as seen above.  
 
The following is a recommended sequence used to initiate tracking information following a successful system power-up 
and listening station survey.  Most steps and the sequence is not mandatory, so your method may vary. 
 

1. Conduct a noise test: Array����Signal Envelope  Select the Bar Chart display.  Choose all the stations by 
highlighting them, then chose Channel 2, and finally choose 5 HzUhit Start. Watch the noise peaks on the chart, 
expressed in dB. 

 
2. Now set the receiver detection thresholds of all stations to be above the noise peaks that you noticed in the first 

step.  Do this by going to Array����Acoustic Receiver Settings.  Here, you must also set the post ping-receipt 
Blackout Period to be somewhat less than the expected ping interval.  This blackout period helps the system to 
discriminate against echoes.  The recommendation is 100ms less than the nominal ping interval, for example 
900ms for a 1 second ping interval (if you are too close to the ping interval, such as perhaps 990ms for a 1 
second interval, then the system may persistently home in on one specific echo). 

 
3. To rule out any outside noise distractions that might register, go to: Mobile����Position Estimation 

Filter����Settings.  These Range Filter options determine the treatment of pinger signal reports from individual 
listening stations (i.e. raw ranges): 

a. Maximum Range: The maximum accepted distance from a listening station.  Use to eliminate impossible 
or undesirable large and probably unreliable measurements.  

b. Minimum Signal Strength: Signal reports below this strength are considered unreliable and will be 
rejected.  

c. Maximum Jitter: If two successive reports from a listening station indicate an apparent distance change 
more than this amount, then the report is considered unreliable and will not be used. 

These Position Filter options determine the treatment of target positions computed from multiple pinger signal 
reports. 

a. Averaging Period: Averaging is used to reduce the impact of random range measurement variations 
(noise) on the position computations, and thus provide a more accurate depiction of the actual position 
trace.   This is a running average over the specified number of seconds.  The appropriate averaging 
period for a slow target such as a diver may be ten seconds.  A rapidly moving and turning target such as 
a torpedo will require a shorter averaging period to reduce position lag. 

b. Maximum Error: This is the maximum estimated position uncertainty that will be accepted.  Position fixes 
with a greater uncertainty will be rejected. 

 
4. Select the tracking file name by using File -> New Track Record. The Automatic File Name option assigns the 

tracking file a name consisting of the start time and date.  Use the Custom File Name option to assign a more 
descriptive name.  In either case, the tracking data will be a .TRK file stored in the RangeNav/Records/Track 
folder.  The .TRK files are text files that contain all acquired raw tracking information in a text format.  They are 
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used to replay a track (see discussion in next chapter), and are available to export the tracking data into other 
software such as Excel for analysis.  See the RangeNav Software Technical Reference Manual for details.   

 
5. Some of the data windows allow you to log the data as well as viewing it.  All logs are in text format.  The data 

logs are useful to diagnose system performance, such as for example reviewing electrical logs to monitor cable, 
connector and electronics health.  The available logs are: 

a. Array ->Power Control: Array current draw and voltage reported by each listening station. 
b. Array ->Signal Envelope: Acoustic signal seen on a specific channel. Useful to monitor background 

noise or ‘see’ the pinger signal. 
c. Array ->Time of Arrival: Ping time of arrival reports from all listening stations.  Can be used to re-

compute target positions. 
 

6. Activate the target pinger and start tracking.  Move around the display using these functions.  They are also 
described in the box above. 

a. CTRL-Z: Zoom, zoom a rectangle (zoom in +, zoom out -) 
b. CTRL-M: Measure, circle from-to 
c. CTRL-P: Pan, hand. Center on mobile by clicking on mobile box. Center on listening station by clicking 
on its status field. 
d. CTRL-R: Rotate, pie chart from center 

 
 

 
 

Figure 10a: Step 1—Noise Test 
 
 
 
 

Stations report in 

dB, results are the 

outside noise 

Table in dB 

Log data button 



18 

 
 

Figure 10b: Step 2—Threshold Level 
 
 
 
 
 

 
 

Figure 10c: Step 3—Position Estimation Filter Settings 
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Figure 10d: Step 5—Power Control window with Log data button 
 
 

 
 

Figure 10e: Step 5 —Time Of Arrival window with Log data button 
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Screen Shot Of Tracking A Pinger 

 

 
 

Figure 11: Tracking a pinger in a pool 
    
In this exercise the transducers were the only component in the water (other than pinger). I used a TLP-102 and 
walked it around in a circle from inside the pool leaving it in the middle as I walked. Over the course of a minute I 
made a complete circle and turned the pinger off. If you were watching this in real-time then you would see the 
Baseline Stations glowing green as they received the pings.  
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8. Replaying Tracking Records and the RangeNav™ Data Files 
 
Tracking records can be replayed in Replay Mode.  Tracking data is also available in text files.  These files can be 
imported into other software for further analysis of your tracking data. 
 
To play back a track record, simply go to File�Replay Track Record and then find the corresponding track that you want 
to replay (figure 12). This will then bring up some controls (see figure 13). All tracking data is recorded in raw format, i.e. 
signal arrival times, signal strength etc.   Prior to playing the record, you must define your filter settings in Mobile -> 
Position Estimation Filter.  Then, select File->Reprocess Data.   
 

 
 

Figure 12: Selecting A Track To Replay 
 
From here you can play the current track as well as pause it, stop it, fast forward or rewind it, and skip to any point in the 
track. Refer to the controls listed in figure 13. 
 
 
 
 

 

Start time of 
displayed 
track 
segment Length of 

displayed track 
segment File-> 

  Load 
 Reprocess Data 

End time 
of 
displayed 
track 
segment 

To display a specific portion of the 
record, slide the green (start) 
and/or red (end) bar.   
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Figure 13: Controls During Track Replay 

 

 

   
 

Figure 14:  A recording played with no (left), limited (center) and strong (right) filter settings 
 
 
RangeNav™ stores the full tracking record in a text file with a .trk extension.  In addition, select data such as times of 
arrival can also be stored in log files, which are text files with a .log extension.  These files are available for analysis 
of your tracking data using your own software tools.  Figure 15 shows a portion of a .trk file as it appears in Notepad.  
Refer to the RangeNav™ software manual for a full description of these files. 
 

 

 
 

Figure 15: How To Read Array Survey Data 
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9.  Recording Raw Acoustic Data with the RBS-101 Stations 

 
The RBS-101 station can act as an acoustic data recorder.  The recording station can record raw acoustic data from the 
hydrophone while at the same time providing it's normal tracking functions.  Acoustic data is stored on an internal CF 
memory card using the full resolution of the ADC (16-bits) and at the system sample rate, currently fixed at 250 kHz. 
 
A new data file is created each time the user selects to start recording.  The start time of the recording is logged in the 
data file header.  The data can be retrieved from one or more stations at a time.  Data retrieval has minimal impact upon 
tracking operations other than consuming communication bandwidth. 

 
 

RBS-101 Recording Stations 
The model RBS-101 recording station 
are identical to the RBS-100 listening 
stations, except that a CF FLASH 
memory card is integrated and raw 
acoustic data recording firmware is 
provided.  Due to its copper/RS-485 
data interface, umbilical 
communication bandwidth is limited 
and not suitable for continuous raw 
acoustic data transmission by all 
stations in a chain.  (Doing so is not 
normally necessary, because each 
station processes the acoustic data 
and needs to send only short ping 
descriptor packages). 
 
Yet, the RBS-101 station helps when 
there is a need to obtain occasional 
samples of raw acoustic data, such as 
to evaluate background noise or 
measure the noise signature of a 
target.  The surface station can 
instruct any listening station to record 

the raw data.  The data is stored in the FLASH memory, and can be retrieved by the surface station on a bandwidth 
available basis.   FLASH card capacity is 1 GB standard 8 GB optional.  The 1 GB standard capacity is sufficient for 
approx. 30 minutes of raw data recording at the standard sample rate of 250 kHz. 
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9.1. Operation via the RangeNav™ Surface Station Software 
 
The recording station control window is accessible from the main menu under Array->Recording Station Control.  
Selecting this menu item will bring up the Recording Station Control (see Figure 16).  The  Recording Station Control 
will only pop-up if one or more recording equipped stations have been detected in the array. 

 
The Recording Station Control 
consists of a collection of 
controls, one per line, for each 
recording station in the chain. 
 

Each station has four elements:  
The Station Label, the recording 
control button, the download 
control button, and the progress 
bar.   
 
Each control will also pop-up a 
‘tool tip’ when the mouse hovers 
of the control. 
 

 
 
 
 

The progress bar tool tip displays disk usage and download-progress.  Figure 2 illustrates an array containing 6 recording 
stations.   

 
Stations 1955 and 1957 are currently recording data, while data download on station 1958 has just started.  The tool tip 
displayed shows that Station 1957 currently has 5 files stored for a total of 239 MB and is 48% full. 

 
Note: A station can not record and upload recorded data at the same time. 
 
Recording operations should not effect normal tracking operations. 
 
Controlling Recording 
To initiate recording on a station, press the start recording button.  The recording control button will change its text color 
and action text to indicate that the station is recording.  The download control button will become disabled.  The progress 
bar will increment as data is stored.  The actual amount of stored data is displayed by hovering the mouse cursor over the 
progress bar.  The progress bar indicates total storage usage and will be completely filled in when the storage device is 
full. 
 
Recording will be terminated when the recording control button is pressed again.  This will also re-enable the download 
control button. 
 
Multiple stations can be recording at the same time.  Multiple stations can be recording while other stations are uploading 
their recorded data.   
 
Retrieving Recorded Data 
To initiate data retrieval on a station, press the start download control button.  The download control button will change it's 
text color and action text to indicate that the station is sending it's data.   The progress bar will change from indicating the 
total amount of stored data to the total amount of downloaded data.  The progress bar will increment as data is retrieved.  
The actual amount of retrieved data is displayed by ‘hovering’ the mouse cursor over the progress bar.  The progress bar 
indicates total retrieved data size and will be completely filled in when all the recorded data has been downloaded.  An 
estimate of time remaining (based upon download speed) is also displayed in the progress bar tool tip when downloading. 
 
Note:  Currently all data must be downloaded at the same time.  Stopping then restarting a download will cause the 
 entire download sequence to begin again. A station can not record and upload recorded data at the same time. 

 

Figure 16:  Recording Station Control 
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Erasing Recorded Data 
Stored data erasure is done in a single format operation.  This action is performed by right clicking on the Station ID label. 
A confirmation window will pop-up to insure that you really intend to format the storage device.  Upon affirmative 
confirmation ALL data on the storage device will be erased. 
 
The current file number (see below) is reset to 1 each time the storage device is formatted. 
 
Note: A station can not record or upload recorded data at the same time as erasing the stored data. 

 
9.2. Advice for the Download and Use of Raw Acoustic Data 
 
Acoustic data recording creates very large binary files.  Currently, all data recording is at a fixed sample rate of 250,000 
samples per second with a resolution of 16-bits per sample.  This translates to a raw data record size of about 500 Kbytes 
per second.  Consideration must be paid to data download and use. 
 
Acoustic Data Download Speed 
RangeNav™ system communication is full-duplex with a speed of 115,200 bits/sec.  This translates to a ‘physical layer’ 
speed of about 11.5 Kbyte/sec.  As in any system, some bandwidth is used up by overhead.  A conservative assumption 
is that 50% of bandwidth or about 6 Kbyte/sec is available for the data payload.  Since the data acquisition rate is fixed at 
around 500 Kbyte/sec, each second of recorded acoustic data will take about  500 Kbyte / 6 Kbyte/sec = 83 seconds to 
download.    Be aware of this 83:1 ratio when deciding for how long to record data. 
 
Use of the Recorded Data 
The acoustic data files are binary files, following the format described in section 3 below. Such files cannot be directly 
imported into Excel or similar software expecting text files, and in any case they would be too large.  For example, Excel 
limits each column of data to 65536 values, which would cover only 0.26 seconds of recording. 
 
Instead, we recommend processing and analyzing the data with Mathematica, Matlab, or other software that can accept 
raw binary data files or with custom designed software. 
 

9.3. Data File names and Format 
 
Data Filenames 
The downloaded data is stored in separate files.  There will be one file for each time a recording is started.   
 
The files are located in the ..\Records\RawAcousticData\ directory. 
 
Each file is automatically given a name of the form: 
  
 SN_F__MM_DD_YY_HH_MM_SS.adf 
 
 Where: 
  SN   = Station Serial Number. 
  F      = Current File number (i.e 1=first file on the storage device) 
  MM  = 2-digit month number (01 = January) 
  DD   = 2-digit day of the month 
  YY = 2-digit year  
  HH  = 2-digit Hour     (0-24) 
  MM = 2-digit Minute  
  SS  = 2-digit Second 
 The Time/Date Stamp fields are UTC. 
 
The extention “.adf” stands for acoustic data file. 
  
Data File Format 
Each stored data file is a binary file containing a 512 byte header followed by the raw data samples.  Each data sample 
occupies 2 bytes (16 bits).  All multi-byte data types are stored in little endian order (the same as the native format of an 
Intel PC or TI DSP.) 
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Data File Header 
The data file header is made of the following fields: 
 
uint_32bit magic 
uint_32bit version 
uint_8bit[8]   timestamp 
uint_32bit  fileCount 
uint_32bit  startPosition 
uint_32bit  fileSize 
uint_32bit  errorCount 
 
Where: 
 uint_32bit indicates a 4 byte unsigned integer. 
 uchar_8bit[8] indicates a array of 8 1 byte unsigned integers. 
  
 And 
 
 magic  = File start header identifier ( 0xaa5555aa ) 
 version  = File version number 
 timestamp = 64-bit MS Windows timestamp in UTC 
 fileCount = Current File number (i.e 1=first file on the storage device) 
 startPosition = Position of the start of this file on the storage device in units of device sectors 
 fileSize  = Size of the data file in bytes, including 512 bytes for the header 
 errorCount = Count of errors detected during recording. 
      An error can occur if a CF write delay causes data to be lost.  While the storage buffers on the 
      listening stations have been sized to work with 0 errors for tested cf cards, there is still some  
      possibility of data loss due to the non-deterministic nature of the internal CF card controller. 
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10. Tracking Multiple Targets 
 
 
General Overview 
The system operation for tracking multiple targets is very similar to the single target tracking described throughout this 
manual.  Here are the key differences: 
 

1. Each target has its own pinger, and each pinger must be set to a different acoustic channel.   
2. In the acoustic channel editor (Setup->Acoustic Channel Definitions), you must select acoustic filters for each 

pinger.  Two filter selections are required per pinger because each pinger emits pings on two frequencies.   
3. There will be one target information box for each target at the bottom of the tracking screen.  The boxes are 

labeled Mobile-1, Mobile-2, Mobile-3U  The target names correspond to the sequence of filters selected in the 
acoustic channel editor.   

4. Each target has its own track point and paints its own trace.  The target symbols are M1, M2, M3U 
5. You can center the display on any tracked target by clicking on its information box.   

 
 
Step 1: Selecting Acoustic Bands and Channels for Multi-Target Tracking 
In order to minimize interference between the multiple target pingers, minimize the impact of background (ambient) noise 
and stay within the processing capabilities of the listening stations, the pingers LF, MF or HF band type), acoustic 
channels and detection filters must be selected with care.   
 
The selection process is guided by this trade-off: 
 

• Using detection filters with more coefficients is desirable, because these filters are sharper and thus filter out 
more of the background noise.  The sharper filters also allow the use of tighter spaced channel within one band.  
However, these filters also require more processing power, and thus limit the number of targets that can be 
tracked.  Therefore, the highest number of coefficients that is still within the processing capability of the listening 
stations should be used.  That limit is currently a total of 2400 coefficients among all filters used, except for the 
system self survey filter.  In practice, that means use a 398 coefficient filter when tracking 1-3 targets, 192 
coefficient filters for tracking 4-6 targets, and 126 coefficient filters for tracking 6-9 targets.  The maximum 
theoretical number of targets supported by RangeNav™ is ten. 

• Pinger band selection (LF, MF and HF) should be such that pingers are spread across the available bands and 
there is a minimum number of pingers in each band.  This in turn allows the greatest channel spacing within each 
band. 

• Pinger channel selection should be such that maximum frequency spacing is maintained.  If possible, don’t use 
adjacent channels such as channel 1 and 2.  Use channel 1 and 3 instead. 

 
The following table shows the recommended filter, pinger and channel selection for tracking 1-6 targets.   
 
Pingers # Coefficients Band & Channel Selections for Pingers 

1 398 #1: MF CH1 

2 398 #1: MF CH1  #2: HF CH1 

3 398 #1: MF CH1  #2: MF CH4  #3: HF CH1 

4 192 #1: MF CH1  #2: MF CH4  #3: HF CH1  #4: HF CH4 

5 192 #1: MF CH1  #2: MF CH4  #3: HF CH1  #4: HF CH4  #5: LF CH1  

6 192 #1: MF CH1  #2: MF CH4  #3: HF CH1  #4: HF CH4  #5: LF CH1  #6: LF CH4 
Notes: 

• Use TLP-100 pinger for LF band 

• Use TLP-101 pinger for MF band 

• Use TLP-102 or TLP-103 pinger for HF band 

Figure 17:  Recommended Band & Channel Selections for Multi-Target Tracking 
 
 
For tracking more than six targets or to meet other project requirements such as use of certain frequency bands or 
pingers only, please contact Desert Star Systems.  We will custom-design the filters to meet the project requirements.  
(Experienced users can design their own filters using ScopeFIR or similar software). 
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While a set of standard filters are found in the Filters sub-folder of the installed surface station software, Desert Star 
system also publishes new filters on occasion.  You can find the latest files on-line here: 
 

http://www.desertstar.com/FAQ/questions/113/RangeNav+Acoustic+Channel+Filter+Files 
 
 
Step 2: Configuring the Pingers and Defining the Acoustic Channels 
Select a set of pingers. Each pinger must be programmed to the correct channel.  That is done by serial programming for 
the TLP-100, TLP-101 and TLP-102 models, and by magnetic switch for the TLP-103.  Refer to the pinger Technical 
Reference Manuals for the programming procedure. 
 
In the surface station software, select the acoustic channels as follows.  
 
Open Setup����Acoustic Channel Definitions in the PLATS software screen.  
 
When you are in the Channel Editor your first channel should be labeled as Ch:1 survey_125000_###.fir. This is the 
array self-survey channel.  The ### stands for the number of coefficients, and must match the coefficient count used in 
the pinger detection filters, i.e. 398, 192 or 126.  After your survey channel is defined click the Add button to start defining 
Pinger 1.  
 

 
Figure 18: Filter drop-down menu 

 
For example, if you are tracking two targets and are following the table, then the first pinger  will be an MF type (TLP-101) 
operating on Channel 1 in the MF band, and the second pinger will be an HF type (TLP-102 or TLP-103) operating on 
Channel 1 of the HF band.  For the first pinger, use files MF_CH1_1_16528Hz_125000_398.fir and 
MF_CH1_2_18518Hz_125000_398.fir.  For the second pinger, use files HF_CH1_1_34482Hz_125000_398.fir and 
HF_CH1_2_36363Hz_125000_398.fir.  A channel editor screen dump for this scenario is shown below. 
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Figure 19: Acoustic Channels for two Pingers following the recommended standard selections 

 
 
Step 3: Tracking Operations 
Tracking can now be started in the same way as for a single target.  There will be one target information box for each 
target, and each target will have its own track point and trace.  You can center the display on any target at any time by 
clicking on its information box. 
 

 

11. System Maintenance 
 
Most of the components of RangeNav do not require much maintenance. Refer to specific technical reference manuals for 
maintenance on each component.  Here are the overall system maintenance guidelines: 
 

• Rinse your equipment off when finished (listening stations and pingers). Pay in articular attention to metal 
components such as the connectors and depth sensor. 

• Prevent excessive water falling onto the STM-100 surface junction box.  It is only splash proof.  Clean the STM-
100 with a dry or moist towel. 

• Check all cables prior to deployment and upon recovery.   Do not use any damaged cable to avoid compromising 
the entire system. 

• Apply a thin film of silicone grease to the rubber molded underwater connectors before mating.  

• Thread the locking sleeves of all connectors until they come to a full stop against the bulkhead connector.  This is 
essential to ensure reliable connections.  Inspect before use! 

• Properly attach the cable strain relief system before use. Inspect your work, paying attention that the shackles are 
secured in the locked position. 

• Do not exceed the 500lb working load of the cable. 

• Do not violate the 6” minimum bending radius of the cable. 

• Inspect the cable upon recovery and set aside any damaged or questionable sections for repair or test. 

• Check back periodically on www.desertstar.com for firmware updates and new Knowledge Base entries. 

• Most importantly, enjoy your underwater tracking work and thanks for using RangeNav™! 
 
 
 
 


